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OPEN NEWSLETTER  April May  2011 

  Coordinators Corner 
 
First of all we would like to wish all our members a very 
Happy Easter. 
 
ASCCA (Australian Seniors Computer Clubs Association) 
which we are a member of has just launched a new site 
it is called “ASCCA Voice”.  
 
www.asccavoice.org 
 
The website is literally designed to give seniors a voice 
online, it’s a web site to share ideas, ask questions and 
tell other clubs around Australia what is happening in 
your neck of the woods. 
 
Here is part two of shortcuts this month we will look at 
shortcuts for internet explorer. 
 
Turn to  Pages 2-3 
 

 MEETINGS April 6 

 
The OPEN meeting begins at 1pm and gives everyone a 
chance to find out what makes the  
“place” tick. 
 
The LCG meeting at 7.15 pm ratifies 
 Accounts  for payment and is  
usually followed  by an interesting   
Workshop. 

Two morning classes in Family History are 
held each month at OPEN. 
Students use either the internet or the club’s 
own CD based history links to locate their an-
cestors and relatives. 
 
Places are limited so make sure you put your 
name on the Registration Form near the front 
desk. 
 
April 13 and 20   10 am ‘til noon 
May 11 and 18    10 am ‘til noon 
 
It is a good idea to have a basic chart made 
out. Father, mother or grandparents with per-
haps a birth or death date or two to begin 
with. 
 

Using Family History Links 
This special class will be held Wed. 13 April 

1pm to 3 pm. 

 
FAMILY HISTORY ON-LINE 

 

. 
 

PSP XI  Graphics  
Advanced graphics with  Eleanor, Karia, 

Sandra, Margaret & Laraine 
 

March 23 1 pm—3 pm 
 April 27 1 pm—3 pm   

 May 25  1 pm—3 pm 

 
SPECIAL CLASS 

 
How to use Power Point Presenta-
tions with various Windows pro-

grams. 
Tony Garrett will demonstate 

What you can do with this popular 
Windows Program. 

 

Level 2—3 Graphics 
 

April 20  1pm to 3 pm 

Basic Graphics  
with Judy, Karia, Laraine & Sandra 

 
April 13   
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To do this Press this 

Display Help F1 

Toggle between full-screen and regular views of the browser window F11 

Move forward through the items on a webpage, the Address bar, or the Favorites bar Tab 

Move back through the items on a webpage, the Address bar, or the Favorites bar Shift+Tab 

Start Caret Browsing F7 

Go to your home page Alt+Home 

Go to the next page Alt+Right Arrow 

Go to the previous page Alt+Left Arrow or Backspace 

Display a shortcut menu for a link Shift+F10 

Move forward through frames and browser elements (only works if tabbed browsing is disabled) Ctrl+Tab or F6 

Move backward between frames (only works if tabbed browsing is disabled) Ctrl+Shift+Tab 

Scroll toward the beginning of a document Up Arrow 

Scroll toward the end of a document Down Arrow 

Scroll toward the beginning of a document in larger increments Page Up 

Scroll toward the end of a document in larger increments Page Down 

Move to the beginning of a document Home 

Move to the end of a document End 

Find on this page Ctrl+F 

Refresh the current webpage F5 
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To do this Press this 

Refresh the current webpage, even if the time stamp for the web version and your locally stored version are Ctrl+F5 

Stop downloading a page Esc 

Open a new website or page Ctrl+O 

Open a new window Ctrl+N 

Open a new InPrivate Browsing window Ctrl+Shift+P 

Duplicate tab (open current tab in a new tab) Ctrl+K 

Reopen the last tab you closed Ctrl+Shift+T 

Close the current window (if you only have one tab open) Ctrl+W 

Save the current page Ctrl+S 

Print the current page or active frame Ctrl+P 

Activate a selected link Enter 

Open Favorites Ctrl+I 

Open History Ctrl+H 

Open Feeds Ctrl+J 

Open the Page menu Alt+P 

Open the Tools menu Alt+T 

Open the Help menu Alt+H 
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Monday 10 am –12  General &  

 1 pm – 3 pm Beginners & PC Sup-
port 

Tuesday 10 am –12  P C Support & Begin-
ners + Mac  

 1 pm – 3 pm  As above 

 7 pm—9 pm PC Support (Night 
Class) 

Wednesday 10 am—noon Special sessions or Meet-
ings 

 1.pm—3 pm As for mornings  
(see rosters) 

 3.30—5.30 P C Support 

Thursday 10 am –12  
 

General &  
Beginners  

 1 pm – 3 pm General &  
Beginners  

 3.30—5.30 Absolute Beginners 

Friday 10 am –12  General &  

 1 pm—3 pm Beginners 

OPEN Session Times 
At Studioworks, 1 Pipeworks Rd, L’ton 

 

Standard Sessions $5.00  
 

SPECIAL  WEDNESDAY SESSIONS 
Please register on the sheets – numbers may be limited  

Date Time Topic Details 
March 30 10 am –noon Basic Graphics Judy, Karia and others help with these classes 

 1 pm—3 pm Power Point know-how With Tony Garrett 

April 6 10 am—12 noon Graphics Workshop Judy,  Karia, Laraine & helpers 

 1 pm— 3 pm OPEN MEETING Hear what’s coming up next month. 

April  13 10 am—12 noon Basic Graphics Judy,  Margaret, Laraine & Sandra 

 1:00—3 pm 
  

Using Family History Links Judy will demonstrate how to use this resource. 

April 20 10 am—noon Family History  Finding your ancestors on line with Judy 

 1 pm— 3.00 Level 2—3 Graphics Using PSP 7 and 8 

April 27 10 am –noon Family History On Line Judy,  Margaret, Laraine & Sandra 

PSP X! 

Advanced Graphics 

                         1 pm— 3pm 

OPEN NEWSLETTER – April—May 2011 

   OPEN will be closed from Good Friday until Easter Tuesday 
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I WANNA HOLD YOUR HAND? 

(or Playing the User Account Control game) 
 

One of our members who recently upgraded from Windows XP 
to a new Windows 7 computer asked for my advice on a 
‘troubling’ message that had appeared on her monitor—
something to the tune of “Do you want to allow this program 
to make changes to your computer?” 
 

It is little wonder that such messages concern computer  users 
as they are often accompanied by a dimming of the screen 
that could be interpreted as some sort of cosmic calamity. 
 

In fact what is happening is a process called User Account 
Control,  a monitoring program introduced with Windows 
Vista  and continued in Windows 7. Its noble intention is to 
warn you that installing a piece of software may have 
unwanted consequences, which is fine if you are an 
inexperienced user  who may be new to the concept of 
installing programs on your computer . But it can be rather 
annoying to be subjected to constant ’grilling’ when you just 
want to perform fairly routine tasks.  
 

In the case that prompted this article the change that was 
being made was an automatic update to the e-mail program 
Mozilla Thunderbird which most experienced users would 
consider to be a  trustworthy program. But as we often say, if 
you are uncertain please ask someone who may have a better 
knowledge of the situation.  The member concerned is to be 
applauded for that decision. 
 

If you consider yourself to be an experienced user and don’t 
wish to be bothered by regular interruptions to your activities 
you can turn User Account Control to ‘Off’. But that is a 
judgement that only you can make.  

EQUIPMENT UPDATE by Dennis 
 

With just a couple of months of the new computing 
year behind us there have already been a significant 
number of changes to our club’s equipment. 
 

Thanks to a generous donation from one of our tutors 
Alan Stickley we now have a fourth Windows 7 
computer. It is the white Dell computer on the back 
row, ‘southern’ side of the room and has been set up 
as OPEN2 to replace the Windows 2000 computer that 
previously occupied that spot. Sadly, personal 
circumstances have prompted Alan to leave the state 
but I’m sure members will appreciate his kind gesture.  
 

We have replaced our long-serving Canon IP4300 
colour printer with an IP4850 model that provides the 
same facilities, including direct printing of  ‘labels’ on 
CDs and DVDs.  
 

A few ‘repairs’ have been required too. OPEN9, another 
of our Windows 7 computers  had to have the hard 
disk replaced but it is now back in service, while its 
’twin’ OPEN15 developed a software problem that 
caused it to take ages to start up. That problem was 
eventually solved by doing a System Restore after 
using Safe Mode to get the computer to ’boot’ more 
speedily. 
 

Early in March we had some Internet problems as a 
result of a faulty modem-router that connects all the 
computers to the ‘Net. Another piece of donated 
equipment, a BigPond home modem, provided a 
temporary fix until a new modem-router was 
purchased.  Finally, Office 2010 has been installed on 
OPEN8 and OPEN14. 

COMMUNICATIONS  
 

In the column to the left I referred to problems 
experienced with our club’s internet connection caused 
by a faulty modem. Before such problems can be 
overcome the information has to be communicated to 
someone who might be able to rectify the situation. 
 

In this instance the problem was only detected through 
an accidental check of the monthly internet usage—it 
seemed highly unusual that there would not have been 
anyone using the ‘Net on a Thursday and Friday, so my 
suspicions were aroused.  
 

Fortunately the problem was able to be diagnosed and 
rectified over the weekend so that members had access 
to the ‘Net the following Monday. 
 

If any hardware or software problems arise during 
classes please notify a tutor who can pass the 
information on to a member of the technical committee.  
 

Most problems may have relatively simple solutions. In 
the last few weeks the failure of a monitor was traced to 
a faulty connection on a 4-point power-board, while a 
lack of sound on another computer was due to a faulty 
power-cord on the set of speakers attached to that 
computer.  
 

A TOP KEYBOARD SHORTCUT 
 

Many people who I have assisted with computer tuition 
at OPEN and elsewhere will probably know of  my 
unwavering preference for using the Save As option 
when saving Word documents and Excel spreadsheets 
etc. After many years of thinking I knew a fair bit about 
MS Office only recently have I discovered that pressing 
the F12 function key will bring up the ‘Save As’ dialog 
box—much easier than clicking the File Menu and 
selecting ‘Save As’. 

OPEN NEWSLETTER – April—May 2011 
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SNIPPETS 
 

CDs and DVDs usually come under the heading of 
Removable Media  - i.e. they can be taken out of your 
computer and can be transferred to other computers and 
’media’ devices. For instance the CDs that you play in your 
car’s CD player can be played in a computer that has the 
capability to play music files. 
 

The use of the Compact Disc (CD) and the Digital Versatile 
Disk (DVD) started in the entertainment industry for the 
storage and playback of music (on CDs) and for movies (on 
DVDs). Somewhere along the track somebody realised that 
they could also be used for storing and transferring the 
digital information that was used on computers.   
 

For many of us in the computer world our most frequent 
encounters with CDs or DVDs relate to installing software or 
using the ‘removable media’ to back up our data.  
 
The table below shows a comparison between the various 
forms of removable media that have been used in the last 10 
years . 

SNIPPETS (continued) 
It doesn’t seem all that long ago that the floppy disk was 
in regular use at OPEN but most members will realise that 
the arrival of the ‘flash drive’ has almost consigned the 
floppy to history—  a flash drive with a capacity of  4 
Gigabytes can be bought for roughly the same price as a 
pack of 10 floppy disks and can contain about  270 times 
as much information or data. 
 

I doubt that many of our current members would have 
seen a Zip Disk, which was similar in size to a floppy but 
about twice as thick. OPEN had some donated to us about 
5 years ago and I can remember seeing a Price tag of $22 
on some of them. They too have become obsolete due to 
more economical forms of media with far greater capacity. 
 

Quite recently some of our members were making a 
backup of a software DVD and were surprised to find that 
the Nero DVD-Burning software reported that there was 
not enough room for the data to be burned on to a blank 
DVD. The reason for this was that the software disk was a 
Dual Layer DVD  which you will note from the 
comparison table  can hold up to 8.5 Gigabytes of data, 
and no matter when or where you went to school, “8.5 
into 4.7 won’t go!”  Fortunately blank Dual Layer DVDs are 
available to purchase  although they are about twice the 
price of the single layer disks. 

 
If you have been to a video hire shop recently you will 
know that Blu-Ray is being proclaimed as the latest, 
greatest way to watch movies. The computer industry has 
again followed in entertainment’s  footsteps with Blu-Ray 
disks being available as a form of removable media. 
However you will require new equipment in the form of a 
Blu-Ray burner, and you may even need a more powerful 
computer. Current price for Blu-Ray disks is around $15 
each.     Dennis Murray 

Media Capacity 

Floppy Disk 1.44 Megabytes 

Zip Disk 100 Megabytes 

CD 700 Megabytes 

DVD 4.7 Gigabytes 

DVD Dual Layer 8.5 Gigabytes 

Blu-Ray Disk 25-50 Gigabytes 

RIGHT-CLICKING YOUR WAY THROUGH THE NEW OPERATING 
SYSTEMS AND OFFICE  

As you navigate your way around Windows Vista or Windows 
7 you ‘ll probably be asking yourself questions such as 
“Where did all the menus go?” or “What happened to my 
toolbars in Microsoft Word?” 
 

Although you can build your own toolbar of frequently-used 
commands in MS Office programs I find that right-clicking is 
a convenient way of  accessing the basic tools that you may 
want to use to format a document in Word 2007 or 2010.  
 

Right-clicking with the mouse will display what are known as 
context menus, with the tools available to you on those 
menus changing depending on what part of the document 
you happen to be in at a given time. In the text area of the 
document you may be likely see tools such as Font, Cut, 
Copy, Paste etc.  
 
When navigating through folder windows (such as 
Computer)  you may wish to change the view of items in the 
folder to Details, List, Icons etc but the menus that we have 
traditionally had access to are not always visible unless we 
change to ‘Classic Folders’. However, right-clicking the 
screen may display a context menu that has that has the tool 
or  command that you wish to use 
 

Being a ‘keyboard man’ from way back I prefer to tap one of 
the ALT keys — doing that will display the menu bar near the 
top of the screen and you will be able to select the options 
you require. That method also works in Internet Explorer for 
those occasions when you want Copy or Print something 
from a web page. 
     Dennis 

OPEN COMPUTING TELEPHONE 63434928 
Between 10 am and 3 pm weekdays. 

VICTOR mobile  0408 174 235 

OPEN NEWSLETTER – April—May 2011 
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Figure 1. The Windows 7 firewall ships with about 130 preconfigured out-
bound connection rules, and you can add more rules if you wish. 
 
You can change the behavior of the Windows firewall by adding new rules or 
modifying the defaults. The how-to instructions for tweaking the Windows fire-
wall are version-specific because the software has changed significantly over 
the years. 
 
XP's firewall is, in essence, a 10-year-old Version 1 firewall. Frankly, almost 
any newer, third-party firewall — free or commercial — can do better. Still, if 
you want to use it, Microsoft offers a thorough guide called "Using Windows 
Firewall." 
 
The Windows firewall was improved in Vista and again in Windows 7. Those 
versions can be manually adjusted in numerous ways. 
 
If you want to truly master the Windows firewall, the best overall resources I've 
found are MS TechNet's "Windows Firewall" page and the nicely detailed 
guide, "Windows Firewall and IPsec policy deployment step-by-step," also 
from TechNet. The writers get a little geeky, but the information is very com-
plete. 

 Windows' built-in firewall fails LeakTest   
By Fred Langa  
 
Windows' built-in firewall does not automatically alert you to 
phone-home sorts of behaviour. 
But you can alter the firewall's default settings, either manually or 
with a free add-on tool 

ª Reader Bill Wolcott wants to adjust the Windows firewall to block outbound, 
phone-home connections. 
"I have been using the Windows 7 firewall and Microsoft Security Essentials 
and been very happy. However, I discovered today that it fails GRC.com's 
LeakTest [site]. Is there a way to adjust the Win7 firewall?" 

ª Yes, Bill. In fact, there are multiple ways. 
 
It can sometimes be useful to know when software on your PC tries to estab-
lish an outbound connection. If the connection isn't one you asked for or in-
volves software that you don't recognize, it could be that malware is attempt-
ing to phone home or otherwise use your connection to transmit information 
for its own purposes. 
 
That's what LeakTest checks for: it installs a small, harmless program on your 
PC that tries to contact the GRC.com servers in a mock phone-home sce-
nario. If your firewall guards against this kind of behavior, it will alert you be-
fore allowing the Leaktest program to go online. If your firewall stays silent, 
then LeakTest shows that malware could phone home from your PC, and 
you'd never know it. 
 
But frankly, I don't worry much about phone-home activity. Think about it: if 
malware has made it onto your machine and is trying to phone home, your PC 
is already compromised. The real solution to phone-home malware is to avoid 
infection in the first place. If your PC stays clean, phone-home protection is 
irrelevant. 
 
I realize I might be in the minority with that view. Many users prefer to have 
their firewall block or flag outbound connections. By default, the Windows fire-
wall does neither. 
 
But it can be made to. Windows 7 ships with about 130 preset firewall rules 
that govern the behavior of its outbound connections. (See Figure 1.) These 
rules apply mostly to basic connections for Windows' own components. 
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On the other hand, if you're just looking for a quick way to slap a block on out-
bound connections, several good third-party guides are available. See, for 
example, addictivetips.com's article, "Windows 7 Firewall outbound protection" 
or PCterritory.net's page on "How to enable Windows 7 Firewall outbound pro-
tection." 
 
But perhaps the most interesting option is Sphinx Software's Windows Firewall 
Control (info). 
 
There are free versions of Windows Firewall Control (WFC) available for Win-
dows 7, Vista, and XP — and Pro versions with additional capabilities (U.S. 
$15-$30) are also available. 
 
WFC sits between you and the Windows firewall. It lets you see and control 
what the firewall is doing — events that otherwise can be hard to monitor and 
manage. 
 
For example, when any software tries to make an outbound connection for the 
first time, WFC pops up a dialog box; you can decide whether to allow that 
connection. (See Figure 2.) If you wish, WFC remembers your decision and 
doesn't bother you when that same software tries to connect again. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2. Here, the free version of Windows Firewall Control is request-
ing permission to allow Internet Explorer to go online. Other connec-
tion-control parameters are offered, as well. 
 
The major downside to WFC is that it's intrusive when you first set it up. Your 
PC probably has dozens of programs and services that use your network 
connection, and WFC asks you about all of them as each tries to connect for 
the first time. 
 
The free versions of WFC are also nagware: you get a pop-up dialog box 
from time to time, asking you to register. (If you use and keep WFC, I hope 
you do register — to reward the software authors for their time and effort.) 
 
Again, I don't worry much about blocking phone-home events. Instead, I pre-
fer to focus on prevention: keeping malware off the system in the first place. 
 
But if you want to tweak the Windows firewall for outbound protection or for 
any other reason, now you have the tools!Craig Collins has a file that won't 
update: 
"I am running Windows 7. Windows Update prompts me to download and 
install Service Pack 4 for SQL Server 2005. When I try to do so, the update 
fails, and I get the error code 51E. How do I go about installing it?" 

That error code relates to problems with SQL service groups. It's common 
enough that it has its own Microsoft Knowledge Base article, 957008: "SQL 
Server 2005 Service Pack 2 is not successfully updated when you try to install or 
to uninstall a security update." 
 
The fixes discussed in that article ought to do the trick for you, Craig! . 
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IN S E RT IN G  T H E  US ER 'S  
AD D R E S S  
Word automatically maintains several items of information about you, as a 
user. One such item is your address, which is changed on the User Information 
tab of the Options dialog box. If you want to automatically insert the user 
address in your documents, you can follow these steps: 

1. Position the insertion point where you want the address inserted. 
2. Make sure the Insert tab of the ribbon is selected. 
3. In the Text group, click Quick Parts. You’ll see a drop-down menu. 

4. Choose Field. Word displays the Field dialog box. 
5. In the Categories drop-down list, choose User Information. 
 

 

 

CO P Y IN G  VA LU E S  
There are many ways that you can use Excel's tools to fill out various cells in a 
worksheet. One of the most common tools is to copy a cell (or cells) and then 
paste them into other cells. The only problem with this approach is that when you 
copy cells, you also copy the format of the original cells into the target cells. What 
if you just want to copy the values from the original cells, but retain the formatting 
already applied in the target cells? 

You probably already know that you can use the Paste Special option from the 
Home tab of the ribbon (Excel 2007 and 2010) or the Edit menu (older versions of 
Excel), and then choose the Values option to paste just the values. If the target 
cells are right next to the original cells, there is an even easier way to accomplish 
the same task. Simply follow these steps: 

1. Select the original cells whose values you want to copy. 
2. Right-click on the fill handle (at the bottom right-corner of the selection) 

and drag the selection to encompass the target cells. When you release 
the mouse button, a Context menu appears. 

3. Choose the Fill Values option. Excel fills the target cells with the values 
from the original cells; the formatting remains unchanged. 

Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted by permission 
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ª Comodo firewall and AV fail to self-update  
 
Nik Finney was annoyed that his Internet security solution suffered a silent 
problem that prevented successful updates for months. 
"Early last year, I switched from AVG to Comodo Internet Security & Anti-
virus, largely because of the favorable reviews on the Windows Secrets site. 
"It seemed like a good program, though a little arcane and terse in its mes-
sages when a new situation was encountered. I cannot make a definitive 
statement on its efficacy (I'm not an expert), but it seemed to be doing a 
good job. "Yesterday, I switched to the Admin account on my laptop and 
started to do some housecleaning. Although not part of my normal process, I 
opened up the Comodo interface. Surprise! It informed me that my version 
was not being updated any more — since Nov. 1, 2010!" 

ª Ouch! 
 
The best way I know to make sure all your software is truly up-to-date is to 
use Secunia PSI (site). 
 
PSI is a free, third-party software-update service. Prompted by your note, I 
just tried it out with Comodo's free security software (site); indeed, they work 
fine together. If Comodo's internal updater fails again, PSI should be able to 
let you know automatically. 
 
For more information on PSI, see the Jan. 13 Windows Secrets Top Story, 
"The best way to manage multiple app updates." 
 
Malware can also prevent security-software updating. You might also run an 
on-demand malware scanner such as Malwarebytes (download site). 
 
Starting problems: bad battery, bad disk?  
 
Jim McIntosh's system is acting strangely, and he suspects the hardware: 
"My desktop XP system takes almost a minute to get to the initial BIOS dis-
play during the boot-up procedure. I'm wondering if this is a symptom of a 
motherboard battery that needs replacing. "The disk access light stays on 
most of the time while the system is thinking about booting up. I'm hypothe-
sizing that the system is scanning the hardware at every boot because the 
values have been lost. "Also, I'm wondering whether you can clarify the 
proper procedure for replacing the battery. Should this be done when the 
machine is powered on or off?" 

If your PC is more than about three years old and is still on its first motherboard bat-
tery, then it surely wouldn't hurt to replace it. (They're inexpensive.) If a three-year-old 
or older battery isn't dead yet, it's on its way.  
 
And, yes, the PC should be completely powered off during the replacement. The 
Hardware Secrets site has a good illustrated tutorial called "Replacing the mother-
board battery." 
 
But one of your main symptoms is a constantly lit drive-activity light, so you would do 
well to also test the drive. 
 
I suggest you start with Windows' built-in Chkdsk (check disk) utility. You're running 
XP, so the best instruction for you is in Knowledge Base article, 315265, "How to per-
form disk error checking in Windows XP." Win7 and Vista have very similar versions 
of Chkdsk built in, as well. 
 
Passmark's DiskCheckup (free for personal use, $15 per license for businesses) 
looks for different kinds of drive errors and can supplement the more basic Chkdsk. 
It's worth running any time you suspect a disk problem. 
 
DiskCheckup (info/download) works on XP, Vista, and Windows 7, and it can even 
give you a ballpark estimate of when your drive is statistically likely to fail. 
 
Give it a try!  

PDF created with pdfFactory trial version www.pdffactory.com

http://www.pdffactory.com
http://www.pdffactory.com


Page 13  

Online e-mail service failures: slow recovery   
By Lincoln Spector  
 
Most users of Web-based e-mail services assume that as long 
as they're connected to the Internet, they'll have 24/7 access 
to their accounts. 
 

But a recent Gmail failure proved otherwise. Here's how to create backups of all 
your mail residing in the cloud. 
ª  

 
About 30,000 Gmail users lost their e-mail on the last day of February. Not 
only could they not send and receive messages, they couldn't access any of 
the messages they had sent, received, or archived since they put their trust in 
Google. 
 
Google had backups, but five days after the disaster struck, some people's e-
mail collections were still unrestored. 
 
This very scary incident should work as a wake-up call for anyone who keeps 
e-mail in the cloud. Whether you're using Gmail, Hotmail, Yahoo Mail, or 
something more obscure, if you're doing mail from a webpage, an error made 
by someone thousands of miles away could eliminate thousands of precious 
messages that you chose to save, including vital information from your doctor, 
your accountant, and your boss. 
 
And because that error would probably rob thousands of other people of their 
mail, too, you wouldn't receive careful service, concentrating on you, from the 
company at fault. 
 
If you don't want to give up the convenience of Web-based e-mail (and I sure 
don't), you've got two options: accept the possibility of losing mail, or back up 
your cloud-based mail to your local system. 
 
Because I'm not the live-dangerously type — and I'm betting you aren't, either 
— here's how to put a copy of your mail on your hard drive. I've kept my in-
structions as broad as possible, so they'll work with any Web-based mail ser-
vice. But I include specific instructions for Gmail, Hotmail, and Yahoo Mail. 
 
Use a local e-mail client as your backup app  

 
The trick to backing up cloud-stored e-mail is to use a local e-mail client such 
as Thunderbird, Outlook, or Windows Mail. 
 
No, I'm not suggesting you give up your beloved browser-based e-mail inter-
face. You can still do all your e-mailing in the cloud. You need to load the local 
program only when it's time to run a backup — or in case of a disaster. 
 
You want a client that supports the Internet Message Access Protocol (IMAP). 
Most do — I haven't seen one without it in years. 
 
I'm going to give detailed instructions for Microsoft's free Windows Live Mail 
2011 (download page). The instructions are very close to those you would use 
for other Microsoft mail clients such as Outlook, Outlook Express, Windows 
Mail, and Windows Live Mail for Windows XP (download page). But the basic 
idea works with Thunderbird or any other mail client that supports IMAP. 
 
Unless you use Hotmail. Then you need a Microsoft mail client. (I explain why 
below.) 
 
One advantage of Windows Live Mail is that it stores each message in a 
separate .eml file. A great many programs can read .eml files, and Windows 
Vista and Windows 7 can search the contents of these files. 
 
But be careful how you install the program. Microsoft wants you to install the 
entire Windows Live suite. You need only the mail program for this job — you 
have to make your own decision about anything else you might want. 
 
As an alternative, you might want to consider the free MailStore Home (Figure 
1), which isn't a true mail client but is designed specifically for archiving e-
mail. It's an especially easy program to set up for backing up Gmail and has a 
great search tool. But it stores messages in a proprietary format that leaves 
you dependent on the program. (You can export mail to other formats, but 
that's an extra step.) 
 

(Continued on page 14) 
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ª  
ª  
ª  
ª  
ª  
ª  
ª  

ª Figure 1. MailStore Home is a free application that works with popular 
Web-based e-mail services to archive your mail. 
 
IMAP syncs your cloud-based and local mail  
 
Unlike the more common Post Office Protocol (POP3), IMAP fully synchro-
nizes mail between the Web-based server and the mail client on your PC. 
When you synchronize, your local mail client records which e-mails arrived 
and which you sent, deleted, or moved to another folder. The result is an ac-
curate local record of your Web-based e-mail. 
 
Although most e-mail clients support IMAP, that's not the case for Web-based 
mail services. Of the three most popular services — Gmail, Hotmail, and Ya-
hoo Mail — only Gmail supports IMAP. If you use a lesser-known service, 
check the documentation to see whether you have IMAP support. 
 
You have to turn on Gmail's IMAP support before you can use it. While you 
are signed in to your Gmail webpage, click the Tools icon (it looks like a 
sprocket wheel) in the upper-right corner and select Mail settings. Near the 
top of the page, click Forwarding and POP/IMAP. At the bottom of the page, 
select the Enable IMAP option and click Save Changes (circled in yellow in 
Figure 2). 
 

(Continued from page 13)   
 
ª  
ª  
ª  
ª  
ª  
ª  
ª  
ª  
ª  
ª  
ª  
ª  
ª  
ª  
ª  
ª  
ª  
ª  
ª  

ª Figure 2. To turn on IMAP support in Gmail, go to its settings page and 
click Enable IMAP (circled in yellow). 
 
To set up an IMAP backup account in Windows Live Mail 2011, go to the Ac-
counts ribbon and click the e-mail icon in the New Account section. This action 
launches the new account wizard. 
 
Fill in the appropriate information on first page, and be sure to check the 
Manually configure server settings option (see Figure 3) before clicking 
Next. 
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simply downloads new mail onto your PC and then deletes the messages from 
your Web-based inbox. You can often tweak the mail-server settings to delete 
downloaded mail after a set number of days (or to never delete it), but that's about 
it. It won't download to your hard drive messages you sent or moved to another 
folder while using the online mail app. So the only local backup you'll have is a 
raw list of received mail. 
 
If you're using Yahoo Mail and Hotmail, other options can give you IMAP-like syn-
chronization (see below). But for most sites that lack IMAP support, your best bet 
is probably MailStore Home. Because it's designed specifically for archival pur-
poses, it does a reasonably good job synching the Inbox. Just don't expect it to 
sync your outbox or folders that you have created yourself. 
 
The unofficial Yahoo-IMAP connection  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Yahoo doesn't support IMAP, but there's a program that can trick it into doing so. 
That program is the Yahoo IMAP Connector (info). It's not free, however. After a 
15-day trial period, it will cost you $10 to keep using it. 
 
Connector runs in the background, providing a virtual IMAP translator between 
Yahoo's mail servers and your e-mail client. After it's running, you simply set up 

(Continued on page 16) 

  
 
ª  
ª  
ª  
ª  
ª  
ª  
ª  
ª  
ª  
ª  
ª  
ª  

ª Figure 3. You can use various Microsoft e-mail clients on your PC to 
sync Hotmail messages with a local inbox. 
 
On the next page, select IMAP for the Server type. You need information from 
your e-mail service to fill in the rest of the fields. Here's the information for 
Gmail: 
Server address: imap.gmail.com 

ª Port: 993 
ª Requires a secure connection: check 
ª Authenticate using: clear text 
ª Sign-in username: {your e-mail address} (You can skip "@gmail.com.") 
ª Outgoing server address: smtp.gmail.com 
ª Port: 465 
ª Requires a secure connection: check 
ª Requires authentication: check 
By default, the program begins synching all your online folders (except a few obvi-
ous exceptions such as spam and trash) as soon as you finish setting up the ac-
count. The synching happens in the background. 
 
POP presents significant archiving drawbacks  
 
If your Web-based service doesn't support IMAP, maintaining a local mail backup 
becomes more complicated. POP3 doesn't do synchronization — by default, it 
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 If you are 36, or older, you might think this is hilarious! 
 
Also those who, although younger, can remember some of these things 
 When I was a kid, adults used to bore me to tears with their tedious  diatribes about 
how hard things were. When they were growing up; what  with walking twenty-five 
miles to school every morning Uphill.  Barefoot. BOTH ways.yadda, yadda, yadda 
 And I remember promising myself that when I grew up, there was no way in hell I was 
going to lay a bunch of crap like that on my kids about how hard I had it and how easy 
they've got it! 
 But now that I'm over the ripe old age of forty, I can't help but look  around and notice 
the youth of today. You've got it so easy! I mean,  compared to my childhood, you live 
in a damn Utopia! And I hate to say it, but you kids today, you don't know how good 
you've got it! 
 1) I mean, when I was a kid we didn't have the Internet. If we wanted to know 
something, we had to go to the damn library and look it up ourselves, in the card 
catalogue!! (how many of you know the Dewey  Decimal System???) 
 2) There was no email!! We had to actually write somebody a letter - with a pen! Then 
you had to walk all the way across the street and put it in the mailbox, and it would 
take like a week to get there! Stamps were 10 cents! 
 3) Child Protective Services didn't care if our parents beat us. As a matter of fact, the 
parents of all my friends also had permission to kick our ass! Nowhere was safe! 
 4) There were no MP3's or Napsters or iTunes! If you wanted to steal music, you had 
to hitchhike to the record store and shoplift it yourself! 
 5) Or you had to wait around all day to tape it off the radio, and the DJ would usually 
talk over the beginning and @#*% it all up! There were no CD players! We had tape 
decks in our car. We'd play our favourite tape and "eject" it when finished, and then 
the tape would  come undone rendering it useless. Cause, hey, that's how we rolled, 
Baby! Dig? 
 6) We didn't have fancy crap like Call Waiting! If you were on the phone and 
somebody else called, they got a busy signal, that's it! 
 7) There weren't any freakin' cell phones either. If you left the  house, you just didn't 
make a damn call or receive one. You actually had to be out of touch with your 
"friends". OH MY GOSH !!! Think of the horror. not being in touch with someone 24/7!!! 
And then there's TEXTING. Yeah, right. Please! You kids have no idea how annoying 
you are. 
 8) And we didn't have fancy Caller ID either! When the phone rang, youhad no idea 

(Continued on page 17) 

an IMAP in the client of your choice (as shown in Figure 4), using the server and 
port information that Connector provides. 
 
 
Figure 4. Use Yahoo IMAP Connector to sync your Yahoo account with your 
local e-mail client. 
 
Two warnings, however: First, I found that it worked on some Yahoo accounts but 
not others. You'll discover quickly enough whether it will work on yours. Second, 
because Yahoo doesn't officially support this program, future internal changes 
could render it useless. In other words, it's a $10 gamble. 
 
Hotmail: Microsoft's IMAP-like environment  
 
Although Hotmail lacks IMAP support, it has its own proprietary synchronization 
technology. By an odd coincidence (tongue firmly in cheek), this technology works 
only with Microsoft e-mail clients. 
 
Fortunately, the programs it works with come with Windows, come with Office, or 
are free downloads. They're Outlook, Outlook Express, Windows Mail, and Win-
dows Live Mail (including both the 2011 and XP versions). 
 
Set up your account in any of these programs as though it were IMAP or POP. But 
when you're asked for the server type, select either Windows Live Hotmail or 
HTTP. (Only one of these appears on the menu; which one depends on the pro-
gram and version you're running). 
 
The one Microsoft e-mail program that doesn't follow this procedure is Outlook 
2010. When you tell it that your new mail account is with Hotmail, it asks permis-
sion to download and install the Microsoft Outlook E-mail Connector. Let it. 
 
You won't have to fill in any details about servers. Microsoft already knows them. 
 
After you set an e-mail program to synchronize with your cloud-based mail system, 
you need to remember to launch the program and run the synchronization every 
week or so. Then, should disaster strike, you're covered.  

(Continued from page 15) 
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who it was! It could be your school, your parents, your boss, your bookie, your drug 
dealer, the collection agent. you just didn't know!!! You had to pick it up and take your 
chances, mister! 
 9) We didn't have any fancy PlayStation or Xbox video games with high-resolution 3-D 
graphics! We had the Atari 2600! With games like 'Space Invaders' and 'Asteroids'. 
Your screen guy was a little square! You actually had to use your imagination!!! And 
there were no multiple levels or screens, it was just one screen Forever! And you could 
never win. The game just kept getting harder and harder and faster and faster until you 
died! Just like LIFE! 
 10) You had to use a little book called a TV Guide to find out what was on! You were 
screwed when it came to channel surfing! You had to get off your ass and walk over to 
the TV to change the channel!!! NO REMOTES!!! Oh, no, what's the world coming to?!?! 
 11) There was no Cartoon Network either! You could only get cartoons on Saturday 
Morning. Do you hear what I'm saying? We had to wait ALL WEEK for cartoons, you 
spoiled little rat-bastards! 
 12) And we didn't have microwaves. If we wanted to heat something up, we had to use 
the stove! Imagine that! 
 13) And our parents told us to stay outside and play. all day long. Oh, no, no 
electronics to soothe and comfort. And if you came back inside. you were doing chores! 
 And car seats - oh, please! Mom threw you in the back seat and you hung on. If you 
were lucky, you got the "safety arm" across the chest at the last moment if she had to 
stop suddenly, and if your head hit the dashboard, well that was your fault for calling 
"shot gun" in the first place! 
 
 See! That's exactly what I'm talking about! You kidstoday have got it too easy. You're 
spoiled rotten! You guys wouldn't have lasted five minutes back in the 1970's or any 
time before! 
 
 Regards, 
 The Over 40 Crowd 
 (Send this to someone you'd like to make smile)  

(Continued from page 16)  
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LAUNCESTON COMPUTER GROUP 
 

Minutes of Meeting held at Studio Works 1 Pipeworks Rd  
March 2 - 2011 

 
Meeting opened 7.25 pm Ivan Turmine (president) in chair. 
 
Apologies: June and Bert Hazzlewood,.Judy Hall, Julie Hjort, Eleanor 
Horder, Glenn Gilpin and Tom Olsen. 
 
Present: Ivan Turmine, Barry Symons, Dennis Murray, Laraine Rist, 
Harvey Tavener, Janet Headlam, Ron Baker, Reinhard von Samorewski 
and Iris Meek. 
 
Minutes of previous meeting confirmed  R Baker/L Rist Car. 
 
Business Arising:  
OPEN had decided that they would not continue with purple wallets for 
Tutors as they held little material different to the clear ones. 
Glenn Gilpin was not present to talk about videoing club assets. 
The group present at the meeting felt that at this stage we should not 
be pursuing interest rates for investments. All agreed as the rate is 
quite low at present. 
Arrangements have been made with MyState to receive our monthly 
statement by phone prior to meetings as statement comes by mail later 
in each month..  
Internet banking is not available to multi signature accounts. 
New signatures have been presented at MyState. 
 

Correspondence:  
Inwards: Copy of notes from June re the joint meeting of LCG-OPEN. 
Telstra re new rates. 
Julie Dunham Independent Living Centre to I Turmine for update of Club 
details. 
. 
Outward: email details of committees of LCG-OPEN to Julie Dunham.  
Moved I Meek/R Baker inward be received and outward endorsed. Car. 
 
Auditors Report:  
Ron Baker presented the report, having studied all the receipts, cheque 
and deposit books of LCG-OPEN and Petty Cash records. His report is 
filed with the AGM Minutes and a copy for the Public Officer Judy Hall. 
 
Financial Report:  
Barry Symons presented the financial report detailing all income. There 
were accounts to pay to TPCC for ink, ACS for rent, Post for box rental, 
Examiner for Public Notice re meetings and R Baker Audit fee. The 
Financial page is attached with minutes in folder. Balance includes 
VICTOR  funds. Moved B Symons/H Tavener. Car. 
 
Barry Symons tendered his resignation due to personal reasons. Moved 
H Tavener/R Baker his resignation be approved. Car. 
The president asked Laraine Rist if she could carry on in the position for 
the time being. She feels quite capable as long as there is support from 
others.  
 
General Business:  
Janet Headlam proposed that if we still wanted to record our assets, she 

(Continued on page 19) 
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could take still images with her camera and with someone helping, keep 
as a record. If this was to be the case, she would like the club to 
purchase an STD card which would be kept solely for club purposes. 
 
Ivan felt the combined meeting was a great success and hopes it can 
become a regular event. 
He wants all committee persons to read the notes and make comment 
at the next meeting. 
Secretary was asked to email notes to all committee who have not yet 
received them. 
He also suggested the club revert to the old method of holding 
committee meetings separately from WORKSHOPS. He felt that this 
could create more interest in what the group is all about. 
 
Tutor coordinator E Horder will try to schedule a Tutors Meeting about 
June 8. 
 
I Meek moved/J Headlam the cleaner be asked if she would accept 
payment by cheque fortnightly of $60. This would put less strain on the 
petty cash. L Rist will follow up. 
 
Dennis Murray had worked on Computer #14 but at present all the 
licences are activated. 
 
From the OPEN meeting: Quotes will be looked at for the dry cleaning of 
the carpet in the club room. Bruce Dineen will be one of the enquirers. 
The state of the filing cabinet was discussed. Judy thought new slides 
may be the answer. Janet will look around to find cost of replacement of 
said cabinet and all findings will be taken to next OPEN meeting. 
Rob Tierney has placed an ad in Prime Time magazine to give the club a 

(Continued from page 18) better profile. 
 
Tom Olsen sent a request for updated email addresses so he can 
remind members when the newsletter goes online. 
 
Glenn Gilpin was not present so Market is again on hold until next 
meeting. 
 
Iris mentioned the coming sessions of Power Point by Tony Garrett and 
Photo Record with Eleanor Horder as some members may be quite 
interested. Eleanor’s class is almost full already. 
 
Judy Hall is presenting Family History and Basic Graphic Classes of a 
morning until further notice. 
 
Next Meeting April 6 at 7.15. 
 
 
The meeting closed at 8.25 and was followed by an excellent talk by 
Dennis on Multifunction Centres, Inserting Tables into Word Documents 
and How to Save documents to PDF or Web format.  
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